# Table of Contents

- **Introduction** .......................................................................................................................... 5
- **Training Overview** .................................................................................................................. 5
  - Who Should Attend? .................................................................................................................. 5
  - Prerequisite .............................................................................................................................. 5
  - Course Goals .......................................................................................................................... 5
  - Getting Connected .................................................................................................................. 5
- **Director’s Station Overview** ................................................................................................... 7
  - Dashboard and Popout Menu .................................................................................................... 7
    - Popout Menu Bar .................................................................................................................... 8
  - My Director’s Station Dashboard ............................................................................................ 10
  - Changing the Panel Layout .................................................................................................... 12
  - Changing the Panel Content .................................................................................................. 14
- **My Folder** ................................................................................................................................. 17
  - Manage My Folder .................................................................................................................. 17
    - Adding Items ......................................................................................................................... 17
    - Editing Items ........................................................................................................................ 20
    - Deleting Items ....................................................................................................................... 21
    - Storing Items ......................................................................................................................... 21
    - Sorting Items ......................................................................................................................... 22
    - My Profile ............................................................................................................................... 22
- **Reports** .................................................................................................................................... 23
  - Delivered Reports ....................................................................................................................... 23
    - Collection Analysis ............................................................................................................... 23
    - Public Access Analysis ........................................................................................................... 24
    - Dimensions and Measures ...................................................................................................... 24
  - Creating Reports ....................................................................................................................... 26
  - Title Lists in Reports .................................................................................................................. 35
    - List Copies by Total Circulation ............................................................................................ 35
  - Filtering and Sorting Columns that Display ............................................................................. 37
  - Filter Feature in Reports .......................................................................................................... 41
  - Reports Toolbar ......................................................................................................................... 48
    - Saving Reports ....................................................................................................................... 50
    - Printing Reports ..................................................................................................................... 53
    - E-mailing Reports .................................................................................................................... 55
    - Design ...................................................................................................................................... 56
    - Calculator .................................................................................................................................. 58
    - Report Settings ....................................................................................................................... 61
    - Grid Menu ............................................................................................................................... 66
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Charts</td>
<td>69</td>
</tr>
<tr>
<td>Creating Charts</td>
<td>69</td>
</tr>
<tr>
<td>Charts Menu</td>
<td>77</td>
</tr>
<tr>
<td>Meters</td>
<td>79</td>
</tr>
<tr>
<td>Creating meters</td>
<td>79</td>
</tr>
<tr>
<td>SwiftLinks</td>
<td>85</td>
</tr>
<tr>
<td>Saving Links</td>
<td>85</td>
</tr>
<tr>
<td>Sorting links</td>
<td>86</td>
</tr>
<tr>
<td>Removing Links</td>
<td>87</td>
</tr>
<tr>
<td>Index</td>
<td>89</td>
</tr>
</tbody>
</table>
Training Overview

Who Should Attend?

This course is intended for the users who want to access library information through the use of Director’s Station reports.

Prerequisite

No class is required.

Course Goals

After completing this course, participants will be able to:

- Identify the components of the Dashboard
- Create a report
- Create a chart
- Create a meter
- Add a shared report to your personal Dashboard
- Remove a report or chart from your personal Dashboard
- Save and remove a public folder report

Getting Connected

Access information to your particular Director’s Station installation will not be provided as part of this training. Your Site Administrator should receive the following information from your SirsiDynix Project Manager:

- URL for your instance of Director’s Station
- Delivered Administrator login and password
- Delivered Director login and password

If you are the Site Administrator, change the administrator password as soon as you receive it. If you are not the Site Administrator, you may need to wait for users to be created and access rights to be assigned before accessing Director’s Station.
The Dashboard is the starting point for collection analysis. Users can select components for their Dashboard from the following sections:

**SwiftLinks** – A panel that contains tabbed lists of delivered and customized reports in a SwiftReports tab, as well as SwiftMeters and SwiftCharts if any have been added to the Dashboard, and General functions that are used by administrators

**SwiftReports** – Delivered and customized reports

**SwiftCharts** – Graphs created from reports

**SwiftMeters** – Notifications for data that has crossed a set threshold or thresholds

**SwiftHelp** – A list of help topics delivered to assist in working with Director’s Station.
Popout Menu Bar

Using the popout menu

1. To open the menu bar, from any point in the application, click on the gray space in the popout bar to display the popout menu.

2. To close the menu bar, from any point in the application, click on the gray space in the popout bar to hide the popout menu.

The Popout Menu includes the following folders or categories:

   **About SirsiDynix** – This section contains a link to the SirsiDynix home page.

   **Documentation** – This folder contains access points to the on-line help and links to SwiftKnowledge documentation.

   **Collection Analysis** – This folder is delivered to contain reports designed to access your SirsiDynix Symphony or Unicorn data. It is divided into functional areas in the library such as Administration, Technical Services, and Public Services. There is also a folder for All Measures All Modules. These are all of the delivered reports in Director’s Station. Each of these reports has links to the appropriate drill-down lists and contain all of the available dimensions and measures.

   **Public Access Analysis** – This folder is delivered to contain reports designed to access your OPAC data.

   **Site Management** – This folder is used by administrators to administer Director’s Station users, groups and access.

   **My Folder** – Use this folder to organize customized reports, alerts, links, and documents.
The Popout Menu bar contains the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Home</strong></td>
<td>Click this icon at any time to return to your Dashboard.</td>
</tr>
<tr>
<td><strong>Manage Menu</strong></td>
<td>Allows users in the Administrators Group to upload, organize, and manage public documents and reports. (This icon is hidden from users not in the administrator group.)</td>
</tr>
<tr>
<td><strong>Manage My Folder</strong></td>
<td>Allows you to upload, organize, and manage your private documents and reports.</td>
</tr>
<tr>
<td><strong>Log Off</strong></td>
<td>Click this icon to exit Director’s Station. If you use the <strong>X</strong> to close the window, you will not immediately clear the session; it will remain active until it expires.</td>
</tr>
</tbody>
</table>
**My Director’s Station Dashboard**

Whenever a user is logged in to Director’s Station, he is associated with a personal Dashboard that is also called a SwiftView. When a user is first created, he will have a blank template SwiftView. The administrator will determine what SwiftViews are available to each user.

When you select a SwiftView, any report links you may have created on My Director’s Station Dashboard will be overwritten with the selected SwiftView links.

**To select a SwiftView**

1. Log in as a new user.
2. Hover over the menu.
3. Scroll down to Select SwiftView:
4. Click the name of a SwiftView (e.g. Directors).

The SwiftViews listed are determined by the group assigned to the user by the administrator.

5. Click Copy SwiftView To / My SwiftView:
6. Click **Yes** to save the template My SwiftView.

A message displays indicating that you may continue working.

7. Log out and back in to confirm the SwiftView Dashboard change and to make changes to the new SwiftView.

The SwiftView is now associated with the new user. All changes made to the SwiftView from this point forward are saved to the user’s personal Dashboard.
Changing the Panel Layout

To Select a Panel Layout

1. Hover over.
2. Click Panel Layout:

3. Select one of the seven panel options given.

The more panels you use, the longer it takes to launch.
4. The appearance of the Dashboard changes:
Changing the Panel Content

To Change the Panel Content

1. Click on the desired panel to expand it:

2. Click the down arrow in the top left corner of the panel. A list of panel types appears:

3. Click on a different panel name in the list. The new panel appears in the expanded view:
4. Click at the top-right corner of the panel or anywhere outside the expanded panel to collapse the panel back to the Dashboard:
My Folder

You upload, organize, and manage documents and reports from Manage My Folder in Director’s Station. My Folder is a personal folder that no other person can access without your username and password. All of your information regarding personal reports, charts, meters, and emails are saved here, as well as other possible links.

By default Manage My Folder contains a My Folder folder and an Email subfolder.

Manage My Folder

Adding Items

To add a new item to My Folder

1. Click the Manage My Folder icon in the popout bar at the lower-left corner of the window.

The Manage My Folder window appears:
2. Click **Add Item**.

The **Add Item** window appears:

3. Choose a tab to begin adding items:
   - **Links** – Add internal and external hypertext links
   - **Folders** – Add subfolders for organizing reports
   - **Documents** – Add any type of document

In addition, you can add items by saving a report, chart, or meter to My Folder.

**To add a new folder to My Folder**

1. From Add Item, click the **Folders** tab.
2. Enter a **Name** for the folder.
3. Indicate whether the item will allow anonymous access.

Allow Anonymous means that the folder will be available before logging in to Director’s Station. If the user clicks open the Popout menu in the initial Director's Station login screen, he will see those items saved as anonymous. Each level of the link, including the Category, must also be set to Allow Anonymous.
4. For **In Folder**, use the drop-down list to select the folder or subfolder where you want the folder to be stored.

5. Click **Save**.

Top level category folders are managed in Manage Categories. There is no limit to the number or depth of subfolders that can be added within a category.

**To add a new link to My Folder**

1. From Add Item, click the **Links** tab.
2. Enter a **Name** for the link.
3. For **In Folder**, select the folder or subfolder where you want the link to be stored.
4. Check **Local Link** if the link is to a local document, not a web link.
5. Enter the **URL** for the link.

A local link includes the drive letter and path to an individual file on the Director's Station server. The path should include the Director's Station root directory:

```
C:\Program Files\SwiftKnowledge Inc\SwiftknowledgeV8\SKWeb
```

Folders of `.html` files can be retained for linking. A Web link requires an `http://` prefix.

6. Add a **Description** if desired.
7. Click **Save**.

**To add a new document to My Folder**

1. From Add Item, click the **Documents** tab.
2. Enter a **Title** for the Document.
3. For **In Folder**, select the folder or subfolder where you want the document to be stored.
4. Select the document **Type**, such as Excel, Word, PowerPoint, or Other from the drop-down list.

Any type of file can be selected. The type indicates what icon will be used on the menu. The icon is displayed next to the type when a type is selected. If you set the type for a Word document to an Excel spreadsheet, the type will be corrected to display the Word icon, and the document will open correctly.

5. Use the Browse button to select a file on your local machine.
When uploading documents it is easiest to start by selecting the File since other fields will auto-populate based on the file information. To fill this field, type the path and file name or browse to the file you wish to upload. The Title and Type will then auto-populate.

6. Add a **Description**, if desired.
7. Click **Save**.

All uploaded documents are transferred over the Internet and stored in the MSSQL DirectorsStationV8 application database. Administrators may want to limit the users who can upload documents since it may have an effect on bandwidth use and disk space. A loading box appears while the document is being loaded. The time to load documents is directly related to the size of the file and the speed at which the data is transferred. If you are uploading a large file during a high traffic time, it may take a significant time to load.

If the original document is updated, this does not effect the uploaded version. If you need to update the uploaded version, you will need to upload the updated version.

**Editing Items**

When editing links it is important to know that all of the menu items are considered to be "links." Once created in the menu, they are all edited in the same way.

The link information is displayed and can be changed. As a general rule you should not edit the URL for any items. Editing these URLs will likely cause the link to stop working. Changing the type of link has no effect other than changing the icon displayed:

1. Click the **Manage My Folder** icon.
2. Click **My Folder** to display the items that may be edited.
3. Select one of the items.

The properties display in the white space.

4. Click **Edit**, and make the desired changes.
5. Click **Save**.
Deleting Items

1. Click the **Manage My Folder** icon.
2. Click **My Folder** to display the items that may be deleted.
3. Select the item to be deleted. The properties display in the white space.
4. Click **Delete**.
5. Click **OK** to confirm.

Deleting a subfolder automatically deletes all the links within that subfolder.

Storing Items

My Folder data can grow quickly and become cluttered and disorganized. You should use the Add Item / Folders option to create a logical structure for organizing your saved links, reports, charts, meters, and documents:
Sorting Items

You can relocate the links in My Folder or subfolders by dragging the links to where you want them in the Manage My Folder window. As you drag a selected report across the My Folder structure hierarchy, the report is highlighted and a green bar displays where the report will be dropped. If you are dropping into a subfolder, the folder will open when the item being dropped is properly positioned:

My Profile

You can use My Profile to change your name, e-mail address, or password:
Reports

Director’s Station is delivered with an All … Measures report template (e.g. All Cataloging Measures) for each Unicorn module. Use these All … Measures templates to create your own custom report views.

Delivered Reports

Collection Analysis

The **Collection Analysis** category includes the All Measures All Modules folder which contains all of the reports designed to access your library’s data. Additional folders are available for you to categorize your public reports:
The following modules are mapped for analysis in Director’s Station:

- Academic Reserves
- Acquisitions
- Authority Control
- Cataloging
- Circulation
- Materials Booking
- Requests
- Serials Control

The reports found in the All Measures All Modules area of the Popout Menu can also be found in the SwiftReports tab in the SwiftLinks panel on the Dashboard and on the SwiftReports panel pull-down list.

Public Access Analysis

**Public Access Analysis** is available for you to save reports derived from the All OPAC Measures report, which contains information about EPS, iBistro, and/or Web2 searches:

![Public Access Analysis screenshot](image)

Dimensions and Measures

Each report is comprised of Dimensions and Measures that allow the user to customize the content of the report.

**Dimensions** are values through which you can see your data. They are typically Unicorn policies or dates used in your
records. Dimensions appear in rows or columns in reports, or at the top in a dimension pool:

To collapse or expand the display of the dimensions in the dimension pool, hover over the line separating the dimension pool from the report area and click and drag the symbol.

**Measures** is a special dimension that contains numeric values that give you a count, total, average, or percentage. Measures never appear in rows, only in columns or in the dimension pool:
Creating Reports

The delivered reports can be used as-is, or they can be used as a starting point to create your own customized reports.

To create a report

1. From the Dashboard, click one of the All … Measures report templates in the SwiftReports tab in the SwiftLinks pane. A report like this appears:

2. Click on a dimension in the dimension pool that you want to use in the report:
3. Drag the dimension you want to display to either the rows or columns area in the report.

4. To replace an existing dimension with the dimension you have selected, position the new dimension over the existing dimension so two **double** arrows display.

If two single arrows display, you can insert the new dimension before (to the left of) or after (to the right of) the current dimension. Only when two **double** arrows display can you swap the dragged dimension with the current dimension:

5. When you have positioned the new dimension so two double arrows display (to replace existing dimension), unclick to release the new dimension.

It will replace the existing dimension in the report area. The original dimension is moved back to the dimension pool area:
6. Click either the All or the green circle next to the All to expand the member list:

7. Click in the box next to the name of the dimension to filter the member list:

A list displays with a Levels tab and a Members tab.

8. Use the Levels tab to select or deselect all of a level.

9. Use the members tab to select or deselect certain members within a level.

When you are working on the Members tab and the dimension is on the row, you need to collapse the All level to change the member list from All to None or back again.
Indicates that if you were to expand All, all of the members will be selected by default.

Indicates that if you were to expand All, none of the members will be selected by default.

Indicates that if you were to expand All, some of the members will be selected, but not the All member.

Indicates that if you were to expand All, some of the members will be selected, as well as the All member.

10. Click **OK**.

The new report appears:
Notice that the All total is the total for all the members, even though you had excluded some.

11. To exclude the total line in the report area, click in the box next to the name of the dimension to filter the member list and deselect the check box next to All:

12. Click OK.

The new report appears, without the total line:
To include more than one dimension in a report

1. Click the dimension in the dimension pool that you want to use and drag it to the rows or columns area in the report where you want it to display.

2. To insert the new dimension above (before) or below (after) the current dimension, position the new dimension over the existing dimension so two single arrows display to the left (before) or right (after) of the current dimension:
3. Release the new dimension. It appears above (if dropped to the left) or below (if dropped to the right) of the original dimension, as you selected:

4. Click in the check box next to the name of the new dimension to filter the member list.

5. Deselect the check box next to All.

6. Click **OK** to automatically expand the member list under each library.

The new report appears:

You can use this same technique to add multiple dimensions to columns.
To limit a dimension in the dimension pool

Another way to further customize your report is to limit a dimension in the dimension pool. While in the dimension pool, the default is set to look at all members of all dimensions. To limit a dimension:

1. Click the down arrow to the right of a dimension:

   ![Dimension Pool Image]

   When you are viewing member lists in the limit pool, you can use the All checkmark to turn all of the members on or off without having to expand and collapse:

   ![Limit Pool Image]
2. Select as many dimensions in the list as you want to limit by.

3. Click OK:

The selected members display in the dimension pool and the data in the grid reflects the selections. Notice that when limiting is done in the dimension pool, the totals only tally those members selected:
Title Lists in Reports

An embedded feature of Director’s Station allows you to display detailed lists that are associated with the values in the cells selected. Lists are available in reports created from most of the cubes. Refer to the Online Help for information about each of the lists that are available.

List Copies by Total Circulation

To create a title list

1. From the Dashboard, click an existing report such as All Checkout Measures (Historical).

You can use a delivered report or one that you have created from one of the delivered reports.

An Administrator can create new reports by browsing the cube and saving the result as a report. However, any report that is created this way will not contain links to detailed lists.

All Checkout Measures (Historical) and All OPAC Measures require you to select a date prior to selecting a detailed list.

2. If you are using All Checkout Measures (Historical) or All OPAC Measures, or if you want to only get details for a specific date range, select a date or dates in any one of the FY or calendar year dimensions:
3. Highlight one or more data cells by positioning your cursor at the upper-left corner of the cell at the beginning of your selection and dragging it to the lower right corner of the cell at the end of your selection.

The Select menu appears.

4. Click the List Copies by Total Circulation selection:

![Image of list copies by total circulation]

The formatted list of copies with the most checkouts opens in a new window.

5. Click the icon in the top-right corner of the window to close the window:

![Image of closed window]

Detailed lists take more time to load if the selected cells have large values. Only one hundred entries are listed at a time. You can page through the list, print to PDF, or export to Excel.
Filtering and Sorting Columns that Display

If you are looking for specific values within the columns of your report, whether it is an All … Measures report or a detailed list, you can filter by column or sort columns by ascending or descending values.

To filter columns of a report
1. Display a report.
2. Click in an empty space next to the column title.
   The menu appears:
3. Click Filter Columns.
   The dialog appears:
4. Check the columns you want to display, and un-check the columns you do not want to display:

```
Filter Columns
- Checkouts and Renewals
- Title
- Author
- Call Number
- Item ID
- Year Published
- Date Copy Created
- Copy Price
- User Profile
```

5. Click OK.

The new report appears:
To sort values within a column

1. Select a report from the Dashboard, or continue working with the detailed list report.

2. Click in an empty space next to the title of the column you want to sort.

3. Click **Sort Column Ascending** or **Sort Column Descending**, as desired:

4. The new report appears with the column sorted as specified. A small up or down arrow appears next to the title of the sorted column indicating which column is sorted and whether the sort is ascending or descending:

5. To remove the column sort, click in the empty space of the column title again.
6. Click Remove Column Sort:

The report returns to its original appearance:
**Filter Feature in Reports**

Another embedded feature in Director’s Station is to filter for specific dimension members. This lookup is useful when you have a lot of members in a dimension and you want to find specific members only.

To use Filter on the rows in reports

1. From the Dashboard, click an existing report.
You can use a delivered report or one that you have created.
2. Click in the box containing the name of the dimension on the row:

A filter box displays.
3. Hover next to the All member and click on the magnifying glass that displays:
A Member Filter box displays:

4. For a single level dimension, leave All in the Filter Children of Member box and select the value you want the children to contain in the Where Children box:

5. Click **OK** to display the members you selected:

6. Click **OK** to accept the filtered values, or continue to refine the display using the checkboxes next to each member before you click **OK**:
The values you select appear in the report:

7. To remove the filter, use the same steps to display the filter Member Filters box, set the filter to No Filter and click OK twice:
You can also use the Member Filter in the dimension pool. Just click the down-arrow to the right of the dimension name to open the limit box. Hover to the right of the All member and click on the Add Member Filter magnifying glass to display the Member Filter box. You must actively select or deselect member checkboxes to change the filtered values here, but you can redisplay the Member Filter as many times as is necessary to look up each member you want to filter by.

To use Value On Filter on data values in reports

1. From the Dashboard, click an existing report.

You can use a delivered report or one that you have created.

2. Click in the column header of the column you want to filter.

3. Select Filter On Value:
4. Select an operation in the Where box.
5. Enter a value in the box if it is presented.

6. Apply to all levels:

7. Click **OK** to accept the filtered values.

   A magnifying glass icon 🕵️‍♀️ displays in the column you filtered to indicate that there is a value filter applied:
8. To remove the filter, use the same steps to display the Value Filters box, set the filter to No Filter, and click OK:
Reports Toolbar

When working within a report, a toolbar displays that may be used to manage your customized report:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Save" /></td>
<td><strong>Save</strong> – Allows you to save modifications to a report in My Folder and/or your Dashboard. A message displays indicating that the report has been saved and you can continue working.</td>
</tr>
<tr>
<td><img src="Image" alt="Save As" /></td>
<td><strong>Save As</strong> – Allows you to save the report to My Folder and/or your Dashboard. You will be prompted to load the new report or to continue working on the existing report.</td>
</tr>
<tr>
<td><img src="Image" alt="Print" /></td>
<td><strong>Print</strong> – Allows you to set attributes such as paper size and layout, or set security on the produced document. Prints the report to a pdf file.</td>
</tr>
<tr>
<td><img src="Image" alt="Email" /></td>
<td><strong>Email</strong> – Allows you to email a report link to another user. The person wishing to view the report must have a Director’s Station login. A copy of the report is automatically saved to the My Folder/Emails folder of the user that emailed the report. The user that receives the email can then save the report to his folder.</td>
</tr>
<tr>
<td><img src="Image" alt="Design" /></td>
<td><strong>Design</strong> – Allows you to choose, arrange and apply desired dimensions, filters, calculations, and other options prior to running the query. This allows for reports to be created and manipulated in a “batch mode” without running queries after each user action, cutting down the time to create a report and the load on the server. The Design mode is the default page displayed when accessing new cubes or can be accessed by clicking the “Design” icon from any existing report.</td>
</tr>
<tr>
<td><img src="Image" alt="Reload" /></td>
<td><strong>Reload</strong> – Allows you to return to the last saved version of the report, including the page layout and report settings.</td>
</tr>
<tr>
<td><img src="Image" alt="Info" /></td>
<td><strong>Info</strong> – Allows you to display information about the report including the date refreshed, which is the last time the cube was processed.</td>
</tr>
</tbody>
</table>
These same icons, along with the options shown below, can be accessed through the Menu at the top-left corner of the report:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Report Settings Icon" /></td>
<td><strong>Report Settings</strong> – Contains two tabs. The General tab allows you to display or hide empty data. It also allows you to determine how subtotals will be displayed. The Layout tab allows you to display or hide elements of the window such as the panel menu and borders, the toolbar, or the organization bar.</td>
</tr>
<tr>
<td><img src="image" alt="Report Filters Icon" /></td>
<td><strong>Report Filters</strong> – Allows you to display and manage any of the report filters you have in play, either in the member lists (dimensions and measures), or in the values (cell data).</td>
</tr>
<tr>
<td><img src="image" alt="Calculator Icon" /></td>
<td><strong>Calculator</strong> – Allows you to add MDX queries to create calculations or calculated members.</td>
</tr>
<tr>
<td><img src="image" alt="Page Layout Icon" /></td>
<td><strong>Page Layout</strong> – Allows you to manage the display of the dimension pool, the chart pane, or the report grid.</td>
</tr>
<tr>
<td><img src="image" alt="Layout Templates Icon" /></td>
<td><strong>Layout Templates</strong> – Allows you to select a different panel layout for the report. Nine options are available. F indicates the Filter (dimension) pool location. G indicates the report Grid location. C indicates the graphic Chart location.</td>
</tr>
<tr>
<td><img src="image" alt="Edit Report Icon" /></td>
<td><strong>Edit Report</strong> – Allows you to view and edit the report XML.</td>
</tr>
<tr>
<td><img src="image" alt="View Query Icon" /></td>
<td><strong>View Query</strong> – Allows you to display the MDX query that is being sent to Analysis Services.</td>
</tr>
</tbody>
</table>
Saving Reports

To save a report

Typically you create a new report by starting with one of the All ... Measures reports, or a report derived from one of these reports. If a report is created by browsing a cube, it will not have any of the options for producing detailed list reports. You can click Edit Report and modify the XML to permit reports created by browsing the cube to allow the detailed lists.

1. Once you have accessed a report and modified it to create a new report, click on the toolbar or Save As in the menu.

The Save As dialog appears. If you are not an administrator, the Save As dialog looks like this:

2. Enter a new Report Name.
3. Enter an optional Subtitle if you want to have more information.
4. Accept My Folder or a subfolder in My Folder as the default selection for Save In Folder.
5. Select a Main Output Type.

This allows you to control the icon that displays alongside the report name in the SwiftView and Menus. The options are Chart
or Grid. Some reports have only one option for selection. If both the chart and the grid are selected in the Page Layout, you can select either as the main output type.

6. If you want the new report to appear on your Dashboard under SwiftAnalysis, choose Yes for Add to SwiftLinks.

7. Click OK to save the report.

To save a report as an administrator

1. Once you have accessed a report and modified it to create a new report, click on the toolbar or Save As in the menu.

The Save As dialog appears. If you are an administrator, the Save As dialog looks like this.

![Save As Dialog]

2. Enter a new Report Name.

3. Enter an optional Subtitle if you want to have more information.

4. Accept My Folder or a subfolder in My Folder as the default selection for Save In Folder or navigate to one of the Public folders or subfolders.
5. Change tabs to **Director’s Station Dashboard**.

6. Select My SwiftView to save to the Administrator’s personal Dashboard.

All of the groups that the administrator belongs to are displayed. By selecting the group names, the administrator can save the current report to all of the selected Dashboards:

```
Save As

Report Name:  All Catalog Measures
Subtitle:  

[ ] My SwiftView  [ ] Administrators  [ ] Directors  [ ] Template

Main Output Type:  Grid

[ ] Lock Report

OK  Cancel
```

This does not save the report to the individual users’ My Director’s Station Dashboard.

The **Main Output Type** allows you to control the icon that displays alongside the report name in the SwiftView and Menus. The options are **Chart** or **Grid**. If the Page Layout contains only one, it is the only option for selection. If both the chart and the grid are selected in the Page Layout, you can select one or other as the main output type.
7. Select the **Main Output Type** you desire for this report.

8. If you wish, select **Lock Report** to prevent other users from making changes to this report.

   The user to "last modify" a report may overwrite the report regardless of the report’s lock status.

9. Click **OK** to save the report.

### Printing Reports

**To print a report**

1. View or create a report, and click ![Print button](image) on the toolbar or in the Menu.

   The Page tab displays by default:

   ![PDF Generation Settings](image)

   2. Enter the name that you want to be associated with the printed report in the **Report Name** field.

   This does not change the name of the report in the Director’s Station.

   3. Accept **Automatic** in the **Orientation** box.

   Automatic will select the best format for the data. You can override this by selecting a specific page orientation option.

   4. Accept the default **Paper Size** or select one of many paper size options.

   5. Select the **Security** tab to display security options:
6. Select the security options you prefer.

If Encrypt Document is checked, a password is required to view the report or any saved PDF created from the report. Checking additional security options allows you to prevent a document created from the report from being printed, copied and pasted, or screen printed.

7. Click OK to print the report to PDF:

The last page of the PDF report provides information about the source of the report:
8. If you wish to keep a static PDF version of the report for future reference, Click Save a Copy.

9. Open the PDF document and use the File / Print option there to print the report.

E-mailing Reports

Your administrator must configure the Email options in Manage Settings for emailing to work.

To e-mail a report

1. View or create a report, then click on the toolbar or Email in the Menu.

Director’s Station displays the following message:

Clicking Yes here puts a copy of the report you are emailing into your My Folder / Emails folder, and opens email so you can send the report link. Clicking No cancels the email process without saving a copy of the report or sending a link to the report.
2. Click Yes to email the report.
   Your email application opens and displays a link to the report.
3. If desired, add any additional text to the email.
4. Add the email address(es) of the recipient(s).
5. Send the email.

Any user accessing this report through the e-mailed link must have a valid Director’s Station login and password. If the recipient clicks Save, he will be prompted to save the report into his own My Folder.

If a user does not have access to Director’s Station, you can still save the report to PDF and email it as an attachment.

**Design**

Use Design to control the display of individual reports.

*To use the designer*

1. View or create a report, then click on the toolbar or Design in the Menu.

The Design dialog appears:

In the delivered All ... Measures reports, all of the Available Hierarchies are displayed in the Drop Filter Fields Here box at
the top, because all of the available dimensions are displayed in the default reports.

2. Drag any of the filters that you do not want to display on your designed report back into the **Available Hierarchies** box in the left-most column:

In the **Drop Filter Fields Here** box, you can click on any of the dimensions to see the available members. You cannot limit members here.

3. Drag and drop dimensions and measures to the **Drop Row Fields Here** or **Drop Column Fields Here** boxes where you want them to appear in your report.

4. If needed, filter members of report dimensions in either the **Drop Row Fields Here** or **Drop Column Fields Here** boxes by clicking on the dimensions.

5. When all desired dimensions, measures, and filters are in place, click **OK** at the bottom of the Available Hierarchies.

6. Review your new report and make any further changes that may be needed.

7. Once perfected, print, email and/or save your report for future use, as needed.

It is faster to use the Design option when creating complicated reports, because the query is not sent to the server until you have completed your selections.
Calculator

Use the Calculator to achieve more detailed results based on calculations on individual fields.

Keep the following information in mind when you are deciding to use the calculator:

- The values created by the calculator do not appear in any report other than the one in which they were created.
- It is possible to copy and paste values into the text box between reports.
- The code that is created is MDX and any valid MDX can be used in the text box.

In previous versions, the practice of grouping dimensions together using the calculator was popular.

Example:

The following item types would be added together for a single JUVENILE group:

- JUV-BOOK
- JUV-AV
- JUV-MAG
- JUV-CD
- JUV-KIT

This practice is virtually obsolete in this new version for the following reasons:

- If you have the dimension on the row, it is possible to subtotal selected members so that you can obtain a total for a specific grouping.
- If you have the dimension in the filter pool, it is possible to select multiple members so you can obtain a limit on a specific grouping.

These additional factors should discourage this practice:

- You cannot obtain title list for any calculated dimension member.
- Performance is degraded when calculated members are used.
To use the calculator

1. View or create a report, then from the Menu click Calculator.

2. Select New to display the Calculator dialog:

After the initial calculation is created, you also have the option to Edit or Delete existing calculations.

3. Select Measures or the dimension your calculation relates to.

Available members display:
4. Click on the first desired member to add it to the calculation box.

5. Type basic calculation symbols (+, -, *, /) and add other measure or dimension members (you can also use parenthesis to force the correct order of operations) to develop a new calculation measure:

6. When the calculation is fully defined, click OK to display the Save box:
7. Enter a **Name** for the calculation as you would like it to display in the report.

8. Select the **Location** group where the calculation will be stored.

The location group will almost always be the same dimension that the members used in the calculation came from.

9. Select the **Format** of the numeric display.

8. Click **Save**.

The new measure or dimension appears in the report:

---

**Report Settings**

Use the Report Settings to determine how a particular report will behave or display. The General tab contains the behavior values. The Layout tab contains options for hiding or displaying several aspects of reports.

**Using Report Settings to Hide Empty Data**

1. View or create a report, and click **Report Settings** from the Menu.

The General tab displays:
The first three options are related to hiding empty data. These are delivered turned on. You can hide entire columns or rows that have no data in any of the cells. You can also hide members in filters that, if selected, would result in no data based on the current grid and other filters that have been set.

**Example:**

If you filtered on BOOK as an item type, the AV home location filter member would not display because there are no BOOK types in AV.

Hiding empty data options may increase the time it takes to execute the query. Hide Empty Member Lists in particular should be turned off if performance becomes an issue when opening filter boxes.

2. Select the options you want.
3. Click OK to save changes.

**Using Report Settings to Show Subtotals**

1. View or create a report, and click Report Settings from the Menu.

The General tab displays. The last option is related to showing subtotals:
2. Click the **Show Subtotals** to display the Top and Bottom options.

3. Select **Top** or **Bottom** to place subtotals either at the top of the member list (under the All, if it is displayed) or at the bottom.

When Show Subtotals is enabled, and you have any filters applied to the dimensions on the rows, the remaining members’ values are subtotaled:

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Total Value</th>
<th>Total Call Members</th>
<th>Total Copies</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>2,912,285</td>
<td>367,335</td>
<td>3,641,668</td>
</tr>
<tr>
<td>Material</td>
<td>214,748</td>
<td>309,115</td>
<td>315,902</td>
</tr>
<tr>
<td>ALCHEM</td>
<td>16,246</td>
<td>12,732</td>
<td>13,000</td>
</tr>
<tr>
<td>CHEMISTRY</td>
<td>7,220</td>
<td>16,204</td>
<td>16,340</td>
</tr>
<tr>
<td>SPED</td>
<td>9,304</td>
<td>16,014</td>
<td>16,634</td>
</tr>
<tr>
<td>MATH</td>
<td>22,084</td>
<td>56,493</td>
<td>57,877</td>
</tr>
<tr>
<td>MISC</td>
<td>80,827</td>
<td>99,223</td>
<td>109,665</td>
</tr>
<tr>
<td>ENGLISH</td>
<td>12,254</td>
<td>39,093</td>
<td>38,765</td>
</tr>
</tbody>
</table>

If you have partial security set on any of the available dimensions, the subtotal can be used too.
Using Report Settings to manage other aspects of reports

Using the Layout tab on Report Settings, you can control whether or not to display the toolbar, organization bar, titlebar, pane borders, or pane menus. Each of these aspects can be seen in this sample report:

To hide or display any of these aspects:

1. View or create a report, then click **Report Settings** on the Menu.
2. Select the **Layout** tab:
3. Check whichever aspects you wish to display and uncheck any you wish to mask.

4. Click OK.

When all aspects are masked, the report shown on the previous page looks like this:
Grid Menu

On each report there is another menu that is available within the grid panel that provides additional options.

These options are available in both the initial grid reports, and the drill-down list reports.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Export" /></td>
<td>Export … – Allows you to export the contents of the report to a comma separated file, or Excel.</td>
</tr>
<tr>
<td><img src="image" alt="Grid Settings" /></td>
<td>Grid Settings – Allows you to change the display, behavior, and format of the grid.</td>
</tr>
</tbody>
</table>

To export a report

1. View or create a report, then click ![Export](image) in the grid menu just above the report columns (NOT the main menu).

A window asking whether you want to open or save the file may appear. The report will be exported as a .csv file into the default spreadsheet application on your workstation:
2. Open and/or Save this file as you would other imported or exported files:

Grid Menu Settings

1. View or create a report, then from the grid Menu, click Grid Settings.

On the General tab, you have options for display, as well as the option to set the report to Multi-Column Sort:
It is necessary to select both a display option and Multi-Column Sort for the setting to change. Additionally the columns have to be defined as sortingenabled="true" in the report XML or the sorting does not work.

2. Select one display option and Multi-column Sort.
3. Click on the Layout tab.

On the Layout tab, you have additional options for display:

4. Select whichever options you desire.
5. Click OK or Apply to save your changes, or Cancel to close without saving your changes.
Charts

Charts give the user the ability to visually analyze the data contained in reports.

Keep the following information in mind when you are creating charts:

- A chart is automatically associated with every grid report that is created. It can be displayed using the Page Layout option.
- Charts that are created by designing the report and then enabling the default chart are more efficient and portable than those created by highlighting cells, which was used extensively in previous versions.
- If you create a chart by selecting cells, you do not have as much flexibility when working with the report.

Creating Charts

To create a chart

1. View or create a report in Director’s Station:
2. In the Menu, select the Page Layout option.

3. Check the Chart checkbox to enable the chart pane:

4. The chart displays along with the report and the grid:
5. Within the grid, select only those measures that you want to include in your chart:

By default, only the All row is displayed in the chart.

6. Click the Chart to display the members under All:

7. Hover over the Menu in the Chart pane to see the options that are available to modify the chart.

8. Select Chart Types to display the types of charts:
9. Use the Chart Settings to swap the axes and show or hide values:
10. Go back to **Page Layout** and hide or reveal the Variables (dimensions/filters) and the Grid:

The chart displays in full screen.

11. Click **Save As** to save the chart.

**To print a chart to PDF**

1. In the displayed report, select **Print** from the toolbar or the Menu.
2. Accept the defaults.
The PDF displays:

If the grid is displayed in the report, the grid will also be printed to PDF.

To use the chart in another application

1. In the displayed report, right-click on the chart:

2. Click Copy Image.
3. Paste the chart into the new application (such as Microsoft Word):

![Chart Image]

**To view data of a chart**

1. Display the chart report:

![Chart Report Image]
2. In the Report window, click **Menu**.

3. Select **Page Layout**:

4. Check the **Variables** and **Grid** sections to enable them. The Report window updates with report information:
5. The Report window updates with report information:

Any time a chart is created using the grid, it is always possible to retrieve the report to modify filters.

Charts Menu

When you create a chart or go to a saved chart, you can modify the appearance with the Menu that displays on the Chart pane of every report. Using Chart Settings and Chart Types, you can change the chart type, swap axes, and make other display modifications. Chart reports are like any other report in that they can also be saved to the Dashboard or emailed to another Director’s Station user:
You can further modify the display of a chart from the Chart Menu by filtering the axes that are in play:

### Measures

<table>
<thead>
<tr>
<th>Levels</th>
<th>Members</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Holds</td>
</tr>
<tr>
<td></td>
<td>Library Use Holds</td>
</tr>
<tr>
<td></td>
<td>Copies with Holds</td>
</tr>
<tr>
<td></td>
<td>Patrons with Holds</td>
</tr>
<tr>
<td></td>
<td>Delinquent Patrons with Holds</td>
</tr>
<tr>
<td></td>
<td>Blocked Patrons with Holds</td>
</tr>
<tr>
<td></td>
<td>Barred Patrons with Holds</td>
</tr>
</tbody>
</table>

### Availability Status

<table>
<thead>
<tr>
<th>Levels</th>
<th>Members</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Intransit</td>
</tr>
<tr>
<td></td>
<td>Not Available</td>
</tr>
<tr>
<td></td>
<td>Available</td>
</tr>
</tbody>
</table>
When you view a report, you may find that some measures are very important, and should therefore be flagged to notify you when one or more thresholds are reached. Meters allow you to determine whether you have gone beyond a threshold value at a glance. Meters are typically saved only to your personal Dashboard and not to any public folders. However, an administrator can save meters across Dashboards.

Keep the following information in mind when you are creating meters:

- You can create as many thresholds for a single value as you need.
- You can create thresholds on multiple values in the same meter.
- If you are creating thresholds on multiple values they should be comparable.

### Creating meters

**To create a meter**

1. Display the report that contains the values you want to meter:
2. Highlight the value or values that you want to track by clicking on the upper left corner of the column or columns you want to select and dragging to the lower right corner of the range.

3. In the Menu that displays, click Create a Meter:

A Set Ranges box displays with three default ranges supplied.

Ranges apply to all cells that are selected.
4. Define each range and add ranges as needed.

To change the color of a range, click on the color block and use the color finder to select the color you want:

5. If you wish to be notified by email when the particular range thresholds have been met, check the Notify box.

6. Click OK to display the meter:
7. Use the Menu in the Meter to make modifications:

From the menu you can make modifications similar to reports and charts. In the example below, the tool bar and organization bar are displayed and the RU-ONLINE library, which is significantly larger than any of the other libraries, is removed from the display. Notice that subtotals are turned on for the report and the subtotal is also listed:
An alert must be saved both to My Folder and to SwiftLinks for it to be available for display in the SwiftMeters panel on the SwiftView.
The SwiftLinks panel on the Dashboard contains links to general administrative links, reports, charts, and meters. Typically, delivered reports are available here for quick access. You may also save customized reports, charts, and meters to the SwiftLinks panel.

**Saving Links**

Director’s Station allows you to save links to your customized reports, charts, and meters. These links appear in the SwiftLinks panel of your Dashboard for easy access.

**To save a link**

1. Click on the toolbar or **Save As** in the Menu options to create a new report, chart, or meter.

The **Save As** dialog appears:

2. Select **Add to SwiftLinks** to save this report, chart, or meter to the SwiftLinks panel on your Dashboard.
Sorting links

Links within the SwiftLinks panel may be sorted by the user. Click and drag each link to rearrange the reports, charts, or meters into any order the user would like.
Removing Links

You are able to remove links within the SwiftLinks panel when you no longer need them. To do this:

1. Click on the SwiftLinks panel and find the report, chart, or meter that you wish to remove.
2. When it is highlighted, click **Remove**:

Removing a link from the SwiftLinks panel on your Dashboard does not remove the report, chart, or meter from My Folder or from Director’s Station. You can delete the report from your personal My Folder if you no longer want it there.

Once a report is removed from SwiftLinks and My Folder, you cannot see it or access it, but it is still in Director’s Station. To remove it completely from Director's Station, you need to contact your Director’s Station administrator who can remove it.
Index

C

Calculator ..........................................................58
Charts .................................................................69
creating ..........................................................69
print to PDF .......................................................73
use in other application ....................................74
Charts menu .......................................................77
Collection analysis reports ..............................23
Creating charts .................................................69
Creating reports ...............................................26

D

Dashboard ..........................................................7
Delivered reports ...............................................23
Design .............................................................56
Dimensions ................................................................24
limit dimension pool ........................................33
more than one in report .................................31
Documents ............................................................19

E

E-mailing reports .................................................55
Exporting reports ..............................................66

F

Filter columns ....................................................37
Filter in reports ................................................41
Folders .............................................................18

G

Grid Menu ..........................................................66
Grid menu settings ............................................67

H

Hide Empty Data ................................................61

I

Items .................................................................17

L

Links ....................................................................19

M

Manage My Folder ............................................17
Measures ..........................................................25
Members
selecting .........................................................28
Menu
reports ............................................................48
Menus
charts .............................................................77
Meters .............................................................79
creating .........................................................79
Multi-column sort ..............................................67
My Director's Station Dashboard ....................10
My Folder
adding documents .............................................19
adding folders ...................................................18
adding items .....................................................17
adding links ......................................................19
deleting items ...................................................21
editing items .....................................................20
managing ..........................................................17
sorting items ....................................................22
storing items ....................................................21
My Profile ........................................................22
My SwiftView ...................................................10

P

Panel content ....................................................14
Panel layout .....................................................12
Popout Menu .................................................... 8
Printing reports ...............................................53
Public access analysis reports .........................24

R

Report Settings ..................................................61
hide empty data ...............................................61
show subtotals ..................................................62, 64
Reports
collection analysis ............................................23
creating ..........................................................23
delivered ..........................................................26
dimensions .......................................................24
filter .................................................................41
measures ..........................................................25
menu ...............................................................48
printing ..........................................................53
public access analysis ....................................24

August 2008